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In this part . . .

Search engine traffic can dramatically impact the success
of your corporate blogging strategy. This part is dedi-
cated to understanding search engines and how you can
improve your results on the search engine results page.

Chapter 8 introduces how search engines find and rank
your corporate blog. You also see how using keywords
correctly helps you appear in relevant searches.

Chapter 9 builds the keyword foundation to help you with
advanced keyword integration techniques. These tech-
niques help you with search engines and guiding visitors
to conversion.




Chapter 8

Making the Most of
Search Engines

In This Chapter
Analyzing keywords
Reviewing how search engines find your content
Using keywords and content to attract search engines
Registering with search engines

Leveraging search engines to increase traffic and conversions

Search engines have changed the way the Internet is navigated. According
to recent statistics, 90 percent of Internet sessions start with or include
a search. Search engines are constantly adjusting their algorithms to push
the most relevant content to the top of the search engine results pages
(SERPs) to keep users happy and coming back.

As the world’s most popular search engine, Google and its algorithms changed
the search engine world forever, allowing Google to dominate the search
engine market. Google’s methodologies incorporate the following criteria:

v+ Popularity: The more links from relevant, authoritative domains back to
your page and domain the more your pages and domains gain in ranking
for the relevant keywords and phrases.

1 Relevance: The more relevant your content is to the keywords or
phrases searched, the better the chances of your site being found for
those keywords or phrases.

1 Recency: The more recent your content is to the keywords or phrases
searched, the better the chances of your site being found for those key-
words or phrases.

v Frequency: The more frequently your content mentions the keywords
and phrases, the better the chances of your site being found for those
keywords or phrases.
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Blogs allow you to write relevant, recent, and frequent content that searchers
are looking for. This is what differentiates a blog from a static Web site as the
ideal method of gaining search engine traffic. Blogs have back-end technology
that allows them to communicate with search engines and with each other.

In this chapter, we provide you with the tools and tips you need to ensure
you are optimizing your content and platform to fully leverage search engines
as a source of relevant traffic.

Understanding How Search
Engines Find Your Content

In the early days of search, programmatic crawlers would find a link to your
site and then consume your page content trying to identify what the page
was about and what results it should be categorized (indexed) for. These
crawlers simply found your home page and then crawled through your site
using the internal navigation. This is why many early Web sites included a
visible sitemap that held all the links to the pages within. Many of the first
search engines used meta data to properly index the page. Meta data is infor-
mation that is not viewable in a Web page but provides additional informa-
tion to programs and applications that require it.

Meta tagging, or the use of embedded keywords and other important info
in meta data, was once an effective way of getting your pages indexed, but
then authors figured out that they could garner a lot of traffic by inserting
irrelevant but popular meta tags. As a result, search engines directed users
to pages they weren’t looking for. Because of this, search engines began to
largely ignore meta tags as a key component of indexing a page.

In the present day, search engines take a much more thorough approach. For
blogs, this approach usually involves the following steps (see Figure 8-1):

1. When you publish your blog on a blogging platform your sitemap file is
published with the updates. A sitemap is a file that contains the paths
of pages within your Web site, their importance, how frequently they’'re
updated, and the time they were last updated. They provide search
engines with a map to find and index the updated content.

2. Once updated, your blog contacts the search engines by using a process
called a ping, which basically pushes your sitemap address to the search
engine.
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3. The search engine queues the request, recognizing that there has been
a change to the site. Blogs that consistently change content are indexed
more often than those that do not.

4. Once identified, search engines check for a robots. txt file in the root
(base) of the Web site with a bot. Short for robots, bots are simply pro-
grams or applications that run repetitive processes across the Internet.
Search engine bots are the processes that connect to your site and cap-
ture the necessary information for crawling and indexing the site.

Your robots. txt file is a gateway and permissions file for the search
engine. If the robots file doesn’t exist, the search engine defaults that it
has permission to crawl the site and begins crawling the site manually
by bouncing from link to link. If the robots file does exist, the search
engine identifies which directories to ignore and which to include, and
tries to locate the sitemap.

An extensible markup language (XML) sitemap is the most efficient
means of providing a search engine with a roadmap of the content you
want it to crawl, how important those pages are, how frequently they
are updated, and when they were last updated.

Without a sitemap, the search engine is left to determine the hierarchy
and importance of the site on its own by crawling from link to link. With
a sitemap, you can better direct the search engine to your pages and
ensure your content is properly indexed.

5. As the bots view your pages, they first check for a meta robots tag to
see if the page should be indexed. Search engines use a combination of
page structure, hierarchy, HTML elements, keyword densities, and syn-
onymous keyword terms to properly identify how the page should be
indexed.

<MBER Keyword density is the ratio of keywords to other words within your con-
tent. Keyword stuffing is a method by which page authors overpopulate
a page with keywords to artificially get it indexed for those terms. If a
search engine determines that the page is “stuffed,” that page can be
buried in the bottom of search results.

6. Search results are updated within the search engine.

Understanding this process is important because it allows bloggers to incor-
porate pinging, robots files, sitemaps, page structure, and keyword usage
into their corporate blogging strategy. The following sections provide you
with the necessary information to understand how to create, implement, and
leverage these tools.
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Building your robots file to allow
search engines permission

The Web Robots Pages (www.robotstxt .org) fully explain the ways
robots. txt files prevent or allow search engines to crawl your site. The
process for generating a robots . txt file is quite simple. To write and install
a robots. txt file for your blog, follow these steps:

Analyze
Content

Analyze
Content

1. Open a plain text editor like Notepad.

2. In the first line, define which bots or search engines (described here
by the term user-agent) you want to provide permission to. Typically,
this is set to give permissions to any bots or search engines. To do
this, insert an asterisk, which is a sort of wildcard symbol, as follows:

User-agent: *

3. If there are directories that you don’t wish the search engines to
index, such as administrative directories, download directories, or
feed paths, indicate them using the word Disallow and a line for each
exclusion, as follows:

Disallow: */feed/
Disallow: /download/
Disallow: /tag/
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If you're running a WordPress blog, you can exclude all default adminis-

trative directories with the path /wp-, as follows:

Disallow: /wp-

4. Add a line to identify where your blog’s sitemap file is located.

Typically, the XML sitemap file is located in the root (base) of the Web

directory, as follows:

Sitemap: http://www.yourblog.com/sitemap.xml

5. Using an FTP application, upload the file to the base of your Web site

in the root directory.

You should be able to navigate directly to the file by simply putting the

path in a browser, like this:

http://www.yourblog.com/robots. txt

A finished example of a robots. txt file is shown in Figure 8-2.

@ http:/lwww.lifelinedatacenters.comitobots.txt - Windows Internet Explorer [=I=EE]
@\_/ - |é4 nttp://unw lifelinedatacenters.com/robots bt " = |‘9| X Hb google external keyword tool o~
Tz Favorites | 8 hittp/// enters.ci bt i - - 2] g v Pagew Safety Tools~w @+

User—-agent: *

Disallow: /wp-—

Disallow: /*.php$

Disallow: /*.inc$

Disallow: */feed/

Disallow: */phpMyAdmin/

Sitemap: http://www.lifelinedatacenters.com/sitemap.xml
Done @ Intemet | Protected Mode: Off A - Bwoew -
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Publishing a sitemap that directs
search engines properly

Many content management systems, including blogs, offer sitemaps; at first
sitemaps were viewable HTML pages that allowed the visitor to navigate the
site and find what they were looking for. Over time, HTML sitemaps have
become less and less common because they were difficult to keep updated
and rarely used by visitors. Most sites don’t incorporate HTML-based
sitemaps anymore.

Content management systems, including blogging platforms, have adopted
XML-based sitemaps. XML-based sitemaps are extremely useful for search
engines because they can be accessed programmatically by search engines.
The search engines agreed to a Sitemap protocol (www. sitemaps.org) for
XML-based sitemaps.

XML-based sitemaps incorporate a site’s hierarchy, a listing of all the pages
within that site, how important the page is, how often the search engine
should return, and when each page was last updated. www. sitemaps.org.

As you might guess, building a sitemap manually can be quite an undertaking.
The best blogging platforms have sitemaps built in without any need for the
administrator to do anything.

The following list describes some different blogging platforms and the way
they implement sitemaps:

1 Compendium Blogware’s corporate blogging platform (www.
compendium.com): This platform has automated sitemapping that’s
optimized to direct search engines through their keyword-optimized
blogs. This is done automatically with no need for you to request or
implement the sitemapping.

v TypePad (www.typepad.com/business): This platform has an option
to enable sitemaps. Go to Weblogs=>Configure>Publicity and select Yes
under Google Sitemaps.

v WordPress (www.wordpress.org): The self-hosted version of
WordPress has quite a few XML sitemap plug-ins, the most popular
being Google XML Sitemaps by Arne Brachhold (www.arnebrachhold.
de). To install this plug-in, follow these steps:

1. Log in to WordPress as an administrator.
2. Choose Plugins=>Add New.
3. Search for XML Sitemap.



Chapter 8: Making the Most of Search Engines

4. Navigate to the Google XML Sitemaps plug-in by Arne Brachhold
and click Install.

5. You may need to enter your FTP login information for the plug-
in at this point.

6. Choose Plugins=Installed and activate the plug-in.

7. Choose Settings=>XML Sitemap to set content priorities. For some
advice on these settings, look at the next section, “Setting con-
tent priorities in your sitemap.”

Setting content priorities in your sitemap

Sitemap generation systems often have advanced settings that allow you to
optimize your sitemap to let the search engines know which content is most
important or to specify which content actually should be included in the
sitemap.

This is an essential step with some blogging platforms like WordPress, which
tend to publish the same content several different ways (in feeds, author
paths, tag paths, archive paths, category paths, and so on).

Optimizing your robots. txt file and sitemap to omit extraneous paths and
promote the direct paths improves the way search engines index your site.

To update the settings for the WordPress XML sitemap:

1. Select (enable) the Write a Normal XML File check box.

This is the most common file that’s consumed by search engines and
should always be included.

2. Select (enable) the Write a Gzipped File check box.

Although this file has a less common file type, it is a compressed version
of the sitemap that’s quicker for some sitemaps to download and read. It
won’t hurt you to include it.

3. Select (enable) the Rebuild Sitemap If You Change the Content of Your
Blog check box.

This is an essential setting. Each time you edit your site, the sitemap will
be reproduced.

4. Test rebuilding your sitemap by clicking the Rebuild Manual link.

If the page times out, you may need to increase the memory limit set-
ting. My blog has over 2,000 blog posts and it required me to increase
the memory to 28M.

171
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10.

11.

. Select (enable) the Build the Sitemap in a Background Process

check box.

If you don’t enable this, each time you write a blog post and publish it, it
will take you longer and longer to commit the post.

. Review the options to increase the priority based on the comment

count in the Post Priority section.

[ find increasing priority this way does not work well. Comments may
be an indication of how controversial or welcoming your post is to feed-
back but not necessarily an indicator of how much business a post will
attract. I recommend that you check the Do Not Use Automatic Priority
Calculation check box.

. Select Automatic Detection and simply name your file sitemap.sml.

Naming the file something else or locating it in a different location could
cause issues when search engines are seeking to find your sitemap.

. In your Sitemap Content, include the home page, posts, and static

pages, but don’t include the others.

Adding additional paths provides unnecessary duplication of your con-
tent with the search engine (more on that later with canonical URLS).

. In the Change Frequencies area, set the home page and posts to

Always. Also, set static pages according to how frequently you update
the pages of your blog. Set the other options to Never.

This ensures the bots are checking your home page and posts consistently,
but are not working on pages that aren’t changing or are unnecessary.

In Priorities, set the posts to 1.0 and your home and static pages next
(0.9, 0.8). The rest of the pages can be set to 0.1.

Priority ranges from 0 (lowest) to 1 (highest). These settings ensure
that your blog posts have the highest priority within your sitemap —
something you definitely want!

Click Update Options to complete the changes. (See Figure 8-3.)

For additional research on the sitemaps protocol, visit http: //sitemaps.org.

Google Webmasters ensure that your sitemap is published and written prop-
erly. To verify your sitemap is published and being accessed by Google,
follow these steps:

1.
2.
3.

Log in to Google Webmaster Tools at www.google.com/webmasters.
Choose Site Configuration->Sitemaps.
Click Submit a Sitemap and enter the location of your new sitemap.

Typically, this location is http: //www.google.com/webmasters.
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4. After your sitemap is submitted, check back after a day or so and
verify that the status is checked and the URLs Submitted column has
an approximate count of your blog posts and pages within your blog.

5. If there are any errors, troubleshoot using the information provided.

Figure 8-4 shows an example of a properly submitted sitemap.

Implementing canonical URLs
in your post pages

There is a lot of confusion on the Internet and within the search engine com-
munity regarding duplicate content. Google publically warned against dupli-
cate content, which they defined as any two Web addresses that have the
identical content within the pages. Many people believed this to mean that
they could never have content published in two pages of the same Web site,
or else their site would be penalized by Google and no longer found in search
engines. Some blogging platforms have been openly criticized because they
publish virtually every piece of content multiple times at different Web
addresses.
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However, Google Webmaster Central explains the issue and goes on to state:

“In the rare cases in which Google perceives that duplicate content may be
shown with intent to manipulate our rankings and deceive our users, we’ll
also make appropriate adjustments in the indexing and ranking of the sites
involved. As a result, the ranking of the site may suffer, or the site might
be removed entirely from the Google index, in which case it will no longer
appear in search results.”

Google has attempted to educate people that Google recognizes that modern
content management systems, blogs, and forums naturally produce duplicate
content and that this is not deceptive. Google Webmasters has even pub-
lished posts on their own blog calling it the Duplicate Content penalty myth.

Blogs have a ton of duplicate content. Within a single WordPress blog post,
for example, several different Web addresses display identical content:

the home page, the post page, the author page, the archive year page, the
archive month page, the archive date page, the tag page, the category pages,
and the feed.
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Blogs and other content management systems organize content in different
paths and hierarchies so that readers can find it easier. Google refers to the
real issue at Webmaster Central:

“In some cases, content is deliberately duplicated across domains in an
attempt to manipulate search engine rankings or win more traffic. Deceptive
practices like this can result in a poor user experience, when a visitor sees
substantially the same content repeated within a set of search results.”

There is a disadvantage to having identical content published on different
Web addresses within your blog, however.

Google uses the number of links to your site to determine its ranking. You
may have many backlinks to your blog post, but many of them may take dif-
ferent paths to the same content. To avoid this, Google, Bing, and Yahoo!
have adopted the canonical URL. The canonical URL is a method of encoding
each of the pages with a single path, meaning that these engines are capable
of picking the best URL among several choices.

Google, Bing, and Yahoo! may have adopted the canonical URL, but that
doesn’t mean all blogging platforms are using it. Blogging platforms like
Compendium Blogware automatically use canonical URLs because they lever-
age content through a multitude of keyword-optimized paths. WordPress

has several canonical URL plug-ins, the plug-in authored by Joost De Valk
(http://yoast.com/-) works well, and an All in One SEO Pack by Semper
Fi Designs offers canonical URLs as an optional component.

To install the canonical URL plug-in for WordPress, follow these steps:

1. Log in to WordPress as an administrator.

2. Choose Plugins=>Add New.

3. Search for canonical within the WordPress Plugin Search field.
4

. Navigate to the canonical URL plug-in by Joost de Valk or the All in
One SEO Pack plug-in and then click Install. Joose de Valk’s plug-in
publishes the canonical element directly in each page header. The All
in One SEO Pack is a comprehensive SEO plug-in that allows you to
edit page titles, meta descriptions, and many other options to tweak
your blog, of which one feature is canonical URL implementation.

5. You may need to enter your FTP login information because the plug-in
will be installed at this point.

6. Choose Plugins=>Installed and activate the plug-in.

7. If you install the All in One SEO Pack plug-in, choose Settings->All in
One SEO and then select Canonical URLs to enable them and enable
the plug-in.
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Using Keywords Correctly

Keywords are the currency of search engines. Search engines really don’t do
a great job at answering questions, but they do analyze content and catego-
rize content for keywords with a high probability. For your blog to attract
search engines, you must use keywords effectively.

To ensure your pages are found for specific searches, you must effectively
use keywords, phrases, or synonymous terms. Even more important, though,
is how you use those keywords within your pages.

Using page components to emphasize
important keywords

Search engines view HTML page components in a hierarchy and the content
from top down as it gauges the importance of the keywords on the page. (See
Figure 8-5.) It’s not easy to view your own pages from the perspective of a
search engine, but here are a few tips:

+* Domain name: Your domain name can have an impact on your search
engine ranking. Blogs typically rank well for a keyword if that keyword is
in the domain name.

1~ Page title: The page title tag is the top element. Using keywords as part
of your page title tag can help place your blog appropriately in relevant
search results.

v Heading tags: These often-underused tags are very important compo-
nents. Search engine optimization sites, such as SEOmoz, have found
that h1, h2, and h3 are the most effective tags in that order. Be sure to
include an h1 tag at the top of your page Within the heading tags, use
keywords. Again, the first words are the most important. A great method
to use is to publish your blog title in an h1 tag on your home page.

1 Meta keywords: Meta keywords have largely been abandoned by search
engines as a resource for indexing page content. Using keywords in your
keyword meta tag won’t do your page any harm.

1 Meta descriptions: Meta descriptions are not visible to the user but are
an HTML component that’s visible and used by search engines. Using
keywords in your meta descriptions can place your content well.

v Post slugs: Post slugs are the text associated with your blog post within
the Web address or Uniform Resource Locator (URL). Most blogging
platforms generate this automatically based on your post title.
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1 Post titles: Post titles formatted as h1 and h2 subheadings with key-
words are an effective element. Review the code within your theme and
in the location of the post title, verify that they are wrapped in an hl or
h2 tag. Many designers use span or div tags without realizing that the
heading tags are an important page element for search engines.

+* Subheadings: Subheadings within your content should incorporate the
use of h3 tags. Avoid using h1, h2, and h3 tags in your sidebar elements.
If you use them, search engines may think your sidebar has more impor-
tant content than your post.

v~ Boldface terms: Using the <strong> html tag around keywords within
your content is very effective. Underlined or italic words may also have
an impact.

1 Image alt and description tags: Many bloggers upload fantastic images
but neglect to take the opportunity to include keyword phrases that are
specific to the image and the post. Leaving the alt or description tags
empty when you insert an image is a lost opportunity.

v~ Internal links: These are links within your posts that point to other
pages and posts within your blog. Internal links provide readers with
opportunities to dig deeper into your blog. They also provide an oppor-
tunity to insert keywords in the title tags of the anchor tag, like this one:

<a href="http://mylinks.com/mypost.com" title="great
keywords">more keywords</a>

Too many people use terms like read more or click here when they could
be inserting some relevant keywords.

v First words of your content. Using keywords and synonymous terms
within your content is important. Placing keywords in the first couple
sentences can improve how your page is indexed, especially if your
pages don’t have meta descriptions.

1 Content placement in HTML: If you view the source of your HTML, is
your content at the top of the page? Many theme designers mistakenly
insert the HTML for sidebars above the HTML for the content. Using
CSS, a designer can place content first. Be sure this is how your theme is
developed; otherwise, the search engine may believe your sidebar con-
tent is more important than your actual blog posts and page content.

1~ Repetition: Repetition is key with keywords. Don’t use a keyword only
once. Instead, find out where you can naturally add the keywords
throughout your content in different combinations. Be sure to incorpo-
rate synonymous terms if it doesn’t make sense to use the exact phrase.

If you really want to see how a search engine views your blog, you can use
SEO Browser (www.seo-browser.com) to find out. Refer to Chapter 5 for
more details.
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<P Search engine optimization experts argue a lot about the impact and weight of
page elements and their overall impact on optimizing a page. The goal of the
preceding list is to provide you with a comprehensive list of elements that can
be optimized on your blog. By covering all, you are not finding alternative key-
words and phrases that will drive traffic.
Finding the appropriate keywords is key to getting your site indexed for
keywords and phrases that people are searching for. Before modifying your
site, then, it’s useful to determine the keywords your site is already getting
indexed for. Within your site’s analytics, you should be able to find keywords
and phrases that you are already being found for. Ensure those keywords and
phrases match what users would search for when trying to find your busi-
ness, products, or services.

<P Combinations of keywords that have search volumes that your site may

already be ranking for are great keywords to start with. If your site isn’t being
found for any keywords yet, developing a list of keywords that have both
search volume and low competitiveness is a great place to start.
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As you decide upon specific keywords to use in your blog to attract traffic,
you must be mindful of the competitiveness of those keywords. At its root,
keyword competitiveness is the number of other domains trying to rank well
for the keywords that you're trying to compete in.

Evaluating keyword competitiveness

Keyword competitiveness is an important element to monitor. If you find a
keyword that’s highly relevant to your company’s products or services, you
should evaluate its competitiveness. To rank high for a keyword, you must be
more popular than other blogs on the Web. Popularity with search engines is
achieved through links to your blog. A highly competitive keyword takes you
much more effort to rank well on.

Google’s keyword tools were developed for you to research and develop
strategies for pay-per-click marketing, not organic search strategies. However,
the competitiveness of pay-per-click aligns well with the competitiveness of
organic search engine results. Competitiveness is determined by the volume
of people bidding on a keyword. If you have a high number of people bidding
on a keyword, chances are that you have a lot of sites competing for that
organic search ranking as well.

Keyword competitiveness is easily measured by monitoring the cost per click
(CPC) in pay per click (PPC) keyword analysis. If companies are willing to pay
more for traffic via paid search engine advertising, you can be assured that the
organic competitiveness for those keywords is high as well. You can also use the
Google AdWords Keyword Tool; just enter a term to see its competitiveness.

Evaluating keyword competitiveness can be a science in and of itself. Keyword
competiveness is driven by many more factors than simply the average
search volumes. Some keywords can have seasonality (say, valentines gifts),
and competitiveness is ultimately determined by the search engine results.

If your competition has acquired targeted backlinks (links with keywords in
the anchor tag) and has high search engine authority, you're going to have to
work hard to gain on them.

You need to write blog posts that have an enormous impact in your indus-
try and are linked to by the most authoritative sites on the Web. Sites that
rank well on competitive keywords have a long history and high volumes of
backlinks specifying those keywords, making it virtually impossible to unseat
them. Major corporations with deep pockets spend a lot of money to ensure
their content is distributed and promoted throughout the Web and build
large volumes of backlinks.

As a result, your company might want to target keyword combinations that
are still highly relevant but don’t have as much competition. Lower compe-
tiveness will equate to smaller search volumes. Gaining some visitors from
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relevant, low-volume keywords — known as long-tail keywords — is better
than getting no traffic from terms that you won’t rank on.

Finding long-tail keywords
that drive relevant traffic

Long-tail keywords are typically combinations of three or more words that
have search volumes less than 500 per month. If, for example, you were
trying to get traffic on the topic corporate blogging, using the Google AdWords
Keyword Tool, you'll find other keyword combinations with lower volumes
that are still relevant. For example

v Corporate communications blog gets 48 searches per month on average.

v Corporate blogging best practices gets 36 searches per month on average.

Pursuing these long-tail keywords is a great way of acquiring search engine
traffic. Many long-tail keywords have little or no competition, so you can write
about those topics and typically begin getting relevant traffic immediately.

If acquiring search engine traffic is essential to your corporate blogging
strategy, investing in additional keyword tools is essential. SEOmoz (www .
seomoz.org) is an organization for SEO professionals. Aside from guidance,
SEOmoz has a number of tools developed to assist with search engine optimi-
zation, including several keyword tools.

Researching keywords

You can perform keyword research in several different ways, including the
following:

1 Using Webmasters or Site Explorer: Each of the search engines provide
comprehensive information on the keywords and ranking that your blog
is found for. Google Webmasters and Yahoo! Site Explorer provide the
pages and related keywords that your blog is indexing for. (See Figure 8-6.)
Later in this chapter, you find out how to set up your blog for these
services.

v~ Using your analytics: Within your analytics package, you can also
find the keywords that are driving traffic to your blog through search
engines. (See Figure 8-7.) Although Google Webmasters provide all
search results, your analytics package only shows the keywords that
search engine users actually clicked through to get to your blog.
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Evaluate the results of your analytics. You want to downplay irrelevant
posts and pages by modifying the content so the irrelevant terms are
not used in page titles, post titles, or within the content. It’s essential
that your blog be targeted for keywords you’re trying to gain search
engine traffic on if you wish to have a successful inbound search engine

marketing strategy.

To view the keywords that direct visitors to your blog in Google

Analytics, follow these steps:

1. Log in to your Google Analytics account

2. Select your account from the Accounts list.

3. Select View Report for the profile you wish to view.

4. Select Traffic Sources from the primary navigation menu on the

left sidebar.

5. Select Traffic Sources~>Keywords.

The resulting report (see Figure 8-7) provides you with a list of the
keywords and the volume of traffic you are receiving from each

keyword.



’ 82 Part lll: Engaging Your Search Engine Optimization Strategy

|
Figure 8-7:
Viewing

top search
queries by
keyword to
your blog

in Google
Analytics.
|

& Keywords - Google Analytics#lts=1265604763447 - Windows Internet Explorer [SI=EIE=]
@U = [ nitpsiwwnw googie.com/anaiytics/reporting/keywords?id=4309926p dr=20100107-201002068n » |‘9| % | [ googie external keyword tast » -
- = »
¢ Favorites [ ] Keywords - Google Analytics#lts=1265604763447 - v [ de v Pagev Safetyv Toolsv i@+
G0ugle Analytics Karr douglas@gmail com | Sztings | My Account | Help |Sign Gut
i = S The Marketing Technokogy Blog
Dashbaard Spon |2 £ || B Aok o Dssrocars | - visssiee Anced Segess [ AIVE +
. Intelligence =
E——
2 visitors
Keywords Jan 7, 2010 -Feb 5, 2010
Vata Oci=
700 S 700
""'\ e (I e, / = .\'\ e .-.-'-.\.\.’/ =0T
350 ' e Clanl Pl 4
Search sent 15,025 total visits via 7,491 keywords
Content
Show total | paid | non-paid
P Goals.
Goal Set1 Ee=zm~
[ Custom Reporting Visits. Pages/Visit New Visits Bounce Rate
15,025 1 89.28% 86.36%
o ———— % of Site Toizl: 53.80% g 1.23 (D.57%) £ Site Aug: 30.65% (10.64%) Site Auvg: $3.26% (3.69%)
[ Custom Reports. Kepword None 3 Visits & PagesiVisit | Avg. Time on Site % New Visits Bounce Rate.
@ Anancad Segments
R — 208 110 0021 R 20%
S 138 113 w0021 w2474 s1.50%
e — 188 13 00051 sa.15% saon | | L
() Aout s Repart 130 116 00:00:48 91.54% BT.65%
() Comersin Umarssy 12 114 o0ma2 ESE 0.26%
Geme== 1 108 00011 a1 228
" m 000019 s s
100 112 0032 s2.00% so0% | | _
https://www.goegle.com/analytics/reporting/ad_versions7id=490992&pdr=2010010 @ Intemet | Protected Mode: Off A Brm -

|V

To view the keywords in Webtrends, follow these steps:

1. Log in to your Webtrends account.

2. Select the profile of your blog.

3. Search for “Search Phrases” in the reports list field on the page.
4. Select the Most Recent Search Phrases (Organic) report.

Webtrends provides you with the search engines and the countries
that the searches were made from. (See Figure 8-8.)

Using Google’s Keyword Tool: Google has a few keyword analysis tools.
The Google Search-based keyword tool evaluates your site along with
words and phrases you may wish to target. Google provides you with
keywords related to the site as well as keywords related to the search
words and phrases you add. The Search-based keyword tool is fairly lim-
ited but provides the monthly volume of searches as well as the
competitiveness of those terms.

To view keywords with the Google Search-based keyword tool, follow
these steps:

1. Navigate to Google’s Keyword Tool (www.google.com/sktool).

2. (Optional) Log in to your Google AdWords account to integrate
AdWords details if your business is doing pay-per-click marketing.
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3. Enter your blog URL in the Website field.

4. Enter words and phrases applicable to your business, products,
or services.

5. Click Find Keywords to get a comprehensive list of related key-
words and their competition.

Additionally, you can do research with Google AdWords Keyword Tool.
This tool does not incorporate your domain in the results but can be
used to evaluate keywords and phrases as well.

The AdWords Keyword tool provides a more comprehensive look at
the keywords your blog might attract and can offer much more detailed
information based specifically on the keywords or your domain.

To view keywords with the Google AdWords keyword tool, follow these
steps:

1. Navigate to Google’s External Keyword Tool (https://adwords.
google.com/select/KeywordToolExternal).

2. Enter descriptive words or phrases within the keyword field; be
sure to only enter one phrase per line.
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3. Enter the CAPTCHA (the distorted text you're asked to retype)
and click Get Keyword Ideas to get a comprehensive list of
related keywords and their competition.

You can also select Web site content from the left navigation and
review keyword options that Google believes are relevant to your
site.

v Using third party tools: You can find many other third-party keyword
tools that can be used for research, including the following:

e Wordtracker (www.wordtracker.com) is an online research tool
that provides rich keyword data, related keywords, competitive
data, and allows you to manage your keywords in lists and projects
for campaign tracking.

e SEO Book (www . seobook . com) has a keyword suggestion tool
that’s fast and easy to use. It uses data from Wordtracker.

e Keyword Spy (www . keywordspy . com)offers keyword research
tools, competitive intelligence, searches by search engine,
domains, and keyword.

e SEMRush (www . semrush.com) is an online research tool that
tracks the top 40 million search terms. SEMRush is an outstanding
tool to identify keywords that you’re ranking for that you may have
been unaware of. As well, you can identify competitive data.

e Keyword Discovery (www . keyworddiscovery.com) is an online
tool that compiles keyword search statistics from all the major
search engines. It also offers spelling mistake research, seasonal
search trends, and has tools to identify how keywords are used on
your domain.

e Raven Tools (http://raven-seo-tools.com ) is a comprehen-
sive tracking application for keywords, linking, social media, and
design analysis and has Google Analytics integration.

e Wordze (www.wordze.com) is an online tool for search trends,
keyword research, ranking, and competitive insight.

v~ Using trending topics: Google also supplies some fantastic tools to see
trends with keywords and phrases, like the Google Search-based key-
word tool and Google Trends. Often, keywords change over time. As an
example, the concept formally known as SMS marketing is now typically
searched for using the terms text marketing or mobile marketing.

Google Trends can also be taken advantage of to produce content that
will garner more attention. Many Internet marketers purposefully use
trending topics as link bait — that is, they use terms that are controver-
sial and trending high in search to attract high volumes of search traffic.
This may get your site some additional hits, but you'll find that the irrel-
evance of the traffic will result in huge bounce rates and no conversions.
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Improving Vour Blog’s Keyword Content

Writing posts that use page components effectively gets your pages properly
indexed and found in relevant search results. Review the list of keywords
that you wish to target as a source of inspiration for what to post about.

One method for writing great posts is to first write the post naturally. Be sure
your blog post is informative, compelling, and pithy. After reading your post,
ask yourself, “Would I want to do business with this company after reading
this post?” You may even want to solicit engagement directly in the post.

After the post is fully written, go back and view the post for opportunities
to insert relevant keywords in the post title and content. Try to insert three
to four keywords in your content. Start with the post title, then subhead-
ings and content, and even the meta descriptions, if your blog allows it.
Applications like Compendium actually have a keyword strength indicator
that provides you with feedback on whether or not you’'ve used keywords
that your business has targeted.

N Writing for search engines can actually damage the conversion rates of your

blog and, subsequently, lose relevant prospects. It’s important that you use

keywords effectively — they should never be noticeable. Write naturally!

Adding keywords to meta descriptions

If your blog allows you to update meta descriptions, be sure to use keywords
in your posts’ meta descriptions. The best way to update your meta descrip-
tions in WordPress is by using the All in One SEO Pack plug-in, as follows:

1. Ensure the All in One SEO Pack plug-in is installed and enabled on
your WordPress blog.

For more on this, see the section, “Implementing canonical URLs in your
post pages,” earlier in this chapter.

2. On your Post Edit page, scroll down to the All in One SEO Pack section.

3. If the section is closed, click the arrow on the right side of the section
to expand it.

4. Evaluate your post title. If it sounds compelling and has keywords,
don’t make any edits to it.

5. Enter a description.

Write a compelling description with keywords that will motivate search
engine users to click through to your post.

6. Enter keywords if you’d like; there’s a negligible impact on customiz-
ing the meta keyword data.
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Modifying existing posts to increase
their search engine ranking

In reviewing your blog’s ranking for specific keywords, keep in mind that
unless you're in the top results, you won’t be attracting much traffic. As you
review your ranking, find posts that are ranked in fourth place or deeper and
optimize them to improve their ranking. Optimization occurs a number of
ways, including the following:

v Backlinking: If you have another site or blog, the best way of increasing
your page’s placement for specific keywords is to link to that content
and use the exact keyword phrase in the anchor or title text of the link.

v+ Deep linking: As you're writing new content, link back to the page you
wish to rank better using the exact keyword phrase in the anchor or title
text of the link.

1 Adding comments: A comment on a blog post changes the modification
date and the content of the post and gets it re-indexed. Re-indexing with
a newer date may be all you need to increase the ranking of that content.

1 Changing the post title: If the post title doesn’t include the keywords
that it’s ranked well for, change the post title to reflect those keywords.
Do not change the URL, though — that generates a Not-Found error.

1 Modifying the meta description: If you have the ability to alter a meta
description tag for the page or post, modify it and use keywords once or
twice in the beginning of the description.

v Adding subheadings: Insert subheadings with the keyword or phrase
into the content.

v Applying boldface: If you didn’t already, use <strong> tags to bold the
terms within the post.

v Modifying content: Modifying the content to include the exact keyword
or phrase toward the beginning of the content and repeating the key-
words throughout the content can be effective.

1 Adding synonymous terms: Inserting terms that are synonymous with
the exact search term can be effective.

Don’t overdo it! Stuffing keywords and modifying all these things at once could
look artificial and actually drop your ranking. You still want your content to
look natural so that it draws traffic and, ultimately, business!

Optimizing your content for local searches

Local search, or geographic searches, are searches that incorporate a geo-
graphic term in with the actual search. A local search might have an area
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code, zip code, city, or neighborhood combined with a keyword term. Local
search has continued double-digit growth for the last few years. Google, Bing,
and Yahoo! have integrated mapping and geographic searches directly within
its search results. As the quality of local search results continues to rise, the
volume of geographic searches continues to rise. Comcast saw 79 percent
growth in local searches in a single year.

If your business is regional (most are, even if you don’t want to admit it),
using geographic terms in your content can help you appear on long-tail key-
word searches that include geographic terms such as states, cities, zip codes,
area codes, school districts, street names, and so on.

You can also aim for local map search results. For more on this, and for
details on how to register your business with local searches, see “Putting
Your Business on Search Engine Map Results for Regional Searches,” later in
this chapter.

Registering Your Blog
with Search Engines

Your analytics package only provides you with details of how many visitors
actually opened one of your site’s pages, not details of how your site is repre-
sented in search engines. Because you didn’t have people arrive at your site
doesn’t mean that you are not showing up in search results.

To monitor your appearance on search engines, you must register your blog
with the applicable search engine’s Webmaster tool. Google and Bing offer
Webmasters, Yahoo! offers a Site Explorer tool. Details on registering your
blogs follow this section.

There’s a ton of information available through a search engine’s Webmaster
tools, including what links people are clicking, where you’re found in search
results, problems with your site, evaluation of your site’s speed, and so on.
New tools continue to be added. Take advantage of these free tools to tune
up your blog.

Verifying your blog is located and
indexed by search engines

The easiest method to verify whether or not your blog is located by search
engines is to do a site search on the search engine. This can be accomplished
on Google, Bing, and Yahoo! by entering site:www.yourblog.com. (On
Ask, you can simply enter your domain name.)
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If there are results in each of the searches, you know that your site is indexed
in each. If there are no results, you can manually add each of your sites, as
follows:

v Google (www.google.com/addurl/?continue=/addurl): Enter your
blog’s Web address, and a short description of your blog using key-
words. Enter the verification letters that Google requests and click
Add URL.

v Bing (www.bing.com/docs/submit.aspx): Type the characters from
the picture, enter your domain name, and click Submit URL.

v Yahoo! (https://siteexplorer.search.yahoo.com/submit):
Select Submit a Website or Webpage, type the Web address of your blog
in the field, and click Submit URL.

v Ask (http://submissions.ask.com/ping?http://myblog.com/
sitemap.xml): Substitute the path to your sitemap.xml, enter it in your
browser, and click Go.

Because your site is found in a search result does not mean that each of your
pages is being properly indexed, timely indexed, or that you are being found
in all results that your content is relevant for. To do a more in-depth analysis,
the top search engines all provide tools to Webmasters for analysis, such as
the following:

v Google Webmasters (www.google.com/webmasters)

v Bing Webmaster Central (www.bing.com/webmaster)

v Yahoo! Site Explorer (http://siteexplorer.search.yahoo.com)

Register your site with each of these services and add your blog to each.

Identifying problems in Webmasters
and how to correct them

To maximize the authority of your blog, you want to keep your blog ticking
like a well-oiled machine. Using sitemaps, pinging search engines, using good
page construction, and frequently writing relevant content are keys to opti-
mizing your blog for search engines.

However, issues can damage your blog’s ongoing reputation, such as the
following:
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v~ Links that are not found: If you're moving your blog posts from one
address to another on a WordPress blog, a 301 redirect plug-in will help
you remap your old Web addresses to new ones. This will result in no
404 errors (page not found) and your visitors can still reach your site
from a search engine without interruption.

1~ Pages timing out: If your site’s pages are timing out, you can optimize
your site’s performance a number of ways:

¢ Move to a new host or server with better, faster resources. Avoid
free or cheap hosts. Chances are that they’ll pile your blog onto
a server that’s already extremely busy. Purchasing a dedicated
server can be expensive, but well worth it because performance
has been proven to have an impact on visitors sticking around.

Clean up the number of widgets, gadgets, and plug-ins that may be
causing your site to load slower. Plug-in developers are often ama-
teur developers who don’t realize the significant impact their code
has on site performance. Not only will these slow your site down,
they’re often a distraction from what you really want — a visitor to
convert to a customer.

e Move your images and files to another subdomain or service. A
browser requests one file at a time from a specific subdomain. If
you host your images and your site at www. yourdomain. com,
each file is retrieved one at a time. If you host your files on a sub-
domain — for example, images . yourdomain.com— your pages
will load much faster.

¢ Incorporate Amazon S3, EC2, Akamai, or other content manage-
ment services that will load your sites’ resources much quicker.
These services range in affordability but are extremely helpful
in improving your page download times. Services like EC2 and
Akamai cache components (such as images) regionally; so, regard-
less of where your server is located, all visitors can download the
content quickly.

Don’t underestimate page speed and site performance and their impact
on business. Recently, Google said that it’s actually testing page load
times as a factor in its ranking algorithm. Be sure to get slow pages and
pages that are timing out corrected.

1 Pages that are unreachable: If you don’t have a means of redirecting a
dead address on your blog, don’t ever delete a published post. You're
better off adding additional information in the post. If, for example, you
violated another site’s copyright and had to remove content, make an
edit to the post removing the content, apologize for the indiscretion,
and point to the third party’s Web site.
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Changing content may impact your search engine ranking and how visi-
tors react but removing the post will generate a 404 (page not found)
error and will definitely result in users bouncing.

+* Your blog is not in any search results: If Webmasters displays data
that your blog is being indexed, but you are not receiving any traffic via
search engines, there’s a chance that your blog was buried by Google
because they thought you were trying to deceive them to gain ranking.
Keyword stuffing, duplicate content across domains, or content that’s
full of spam-ridden links (including your comments) may be to blame
here. In short, correct the issues and request consideration at www .
google.com/webmasters/tools/reconsideration.

Rand Fiskin, has an outstanding article on SEOmoz on what to do in the
rare event that you were penalized by Google at www . seomoz.org/
blog/how-to-handle-a-google-penalty-and-an-example-
from-the-field-of-real-estate.

Monitoring your ranking and
how you are being found

Too many businesses launch Web sites and blogs and neglect to ensure that
search engines actually know the sites exist. Your site or blog could cost
your company thousands of dollars in design and execution — don’t waste
that investment on a site that no one can find.

Unfortunately, Google doesn’t provide a simple way for Webmasters to moni-
tor whether their blog’s rank is improving. Webmasters supplies snapshots
from week to week, though. Each week you can download the results and
compare the keywords. You can keep track of changes in a spreadsheet, such
as Excel. To do so, just follow these steps:

1. Copy the previous week’s keywords and rankings in an Excel
Spreadsheet (name it Previous).

2. Add a new sheet and copy the current week’s keywords and rankings
(name it Current).

3. Insert a column in the Current worksheet.
4. In cell A2, add the following formula:
=VLOOKUP (B2, previous!B:C, 2, TRUE) -C2
5. Copy the formula down to the bottom of the data.

The first column will show you how your site has gained or lost in key-
word rankings. If you moved -1, you moved up one position.
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Additionally, you can use a third-party service, such as Authority Labs (www.
authoritylabs.com), to monitor your ranking by keywords over time.
Observing your ranking and how you are changing is key to gaining search
engine traffic. (See Figure 89.)
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A number one ranking on a given search engine results page typically garners
more than 50 percent of all the traffic and the longest on-page time of any of
the results. Keep pushing to get your pages in the number one slot.
@“\NG! Don’t pay attention to all the SEO snake-oil salesmen that boast about getting

sites to Page 1 of search results. Page 1 results aren’t typically too challenging
unless you're attempting to get ranked for a highly competitive keyword. True
SEO professionals will always try to get you that lucrative top result on Page 1.

Putting Your Business on Map
Results for Regional Searches

The majority of businesses, even those who serve national and international cli-
ents, are found locally. With the advent of Yahoo! and Google Maps, geography
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Figure 8-10:
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has become an important strategy for geographically located businesses.
(See Figure 8-10.) Whether you have a single location or locations all over the
world, it’s important that you leverage your geographic location to increase
your visibility in search.

Search engines have incorporated their mapping searches directly in the
search engine results page (SERP) when a geographic keyword is added to
the search. And these searches are getting more popular. In the last year,
ComScore has indicated that local search is up 76 percent. Make sure you're
doing whatever you can to be found regionally — including getting on local
search maps.

There’s no automated means of ensuring that your blog is identified geo-
graphically, although KML is now being accepted by search engines as part of
the Sitemap protocol at sitemaps.org. KML is a standard extensible markup
language (XML) file that is used across multiple geographic information
system platforms for identifying point locations and paths. Using a tool, such
as Address Fix (www.addressfix.com), Webmasters can identify their geo-
graphic location from a street address and download a KML file or KML tags
to include in their site.
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Geographic search is expanding in popularity with the use of mobile devices
and location-based searches and services. Don’t underestimate the power

of geographic search when optimizing your blog and your content. If you're

a regional business or you service regional customers, acquiring a presence
for regional terms will get you business. Tools such as geographic meta tags,
KML files, or geographic micro formats (http://microformats.org/
wiki/geo) have not been widely adopted by search engines to date. Be pre-
pared by adopting these methods for identifying your geographic-based busi-
ness today.

In the meantime, be sure to insert your company’s address in the footer of
your blog. As you write content, insert regional terms as often as possible,
including states or provinces, counties, cities, neighborhoods, area codes,
postal or zip codes, school districts, churches, and other landmarks. As
searchers are looking for local resources, they often combine regional terms
with keywords. By using regional terms, you have a better chance of being
found!

Registering your business with local
search on Google, Bing, and Yahoo!

Each of the search engines has a free process for adding your business to
their geographic search data:
v Google (www.google.com/local/add)
v Bing (https://ssl.bing.com/listings/ListingCenter.aspx)
v Yahoo! (http://listings.local.yahoo.com)
Each of the services allows you to upload information to your listing and
even to manually locate your business by dragging and dropping a marker.
Verification can be done by an automated phone process or by having a veri-

fication postcard mailed to the business. Google will even publish links to
your site and blog on your Google Page.

Adjusting your location on the map
to ensure customers can find you

When you register with local search, be sure to verify the actual location of
your business marker on the map. Address cleansing and geocoding often
gets your business close, but the ability to drag and drop the marker at your

193
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exact location ensures that those people who are mapping directions to your
business find you.

Geocoding is the process of taking a standard mailing address and mapping
it to a latitude and longitude. Typically, the process begins with cleaning the
address programmatically and then calculating the approximate location by
using address information combined with geographic data.

As a result, oftentimes a business address is displayed incorrectly on the
map. The business centers realize this and actually allow you to drag and
drop your marker to the precise location of your business. Verify your mark-
er’s location by zooming in all the way and switching to an aerial view. You
should be able to identify the building you are in and drop the pin directly on
it. Be sure to save your profile once completed. (See Figure 8-11.)

Promoting your entry with
customer reviews

Your entry allows you to include ratings and reviews. Truth be told, a lot of com-
petitors will use the opportunity to write negative reviews about your company.
Stay ahead of them by soliciting your customers to write a review about you.
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A great way of doing this is to hold a raffle for any of your customers who
write a review and give away something substantial. You can get quite a few
reviews by holding a contest like this once in a while. Positive ratings are
quite visible in search results, so you want to maintain your profile.

Using your entry to
publish and offers

Providing an offer on your Google page may drive a lot of traffic to your site,
your blog, and your business. Don’t underestimate the power of a simple
coupon or discount offer to attract new customers.

To add a coupon, click the Coupons tab of Google Local Business Center and
follow the instructions. See Figure 8-12.
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Chapter 9

Whriting Content That Drives
Search Engine Traffic

In This Chapter

Attracting Web traffic from search engines

Writing compelling content that drives search engine traffic
Adding images and diagrams to convey meaning

Using formatting and whitespace effectively

Measuring the effectiveness of your search engine strategy

Fe majority of companies use analytics packages to evaluate their blog-
ging strategy and make changes. As search engines and social media
become more popular, much of your blogs’ activity begins off your site and
beyond the reach of your analytics solution.

Search engine traffic is a key example of an offsite strategy that can dramati-
cally affect the success of your blogging strategy. Bloggers who pay close
attention to search can obtain more than one-half of all traffic from search
engines. That’s a fantastic acquisition opportunity for your company — and
one that cannot be ignored.

Regarding search engine optimization (SEO), some naysayers liken optimiza-
tion to gaming the system. Not only is this not true in theory, but the search
engines continue to provide feedback and assistance to site owners to ensure
their content is optimized properly. The better your blog is optimized, the
more accurate the search results. This improves the quality of the search
engines, their users’ experiences, and ultimately gets the right searcher to
your blog. The three critical “P’s” of marketing are product, pricing, and
placement. SEO improves two of those three P’s, ensuring that your pages
are placed properly and found by those who are searching for products and
services that you offer.
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When searchers view your entry on a search engine results page, they
haven’t arrived at your blog yet. If your site isn’t on the search engine
results page, how would a prospect even know that your site or blog exists?
Companies sometimes spend thousands of dollars on their Web presence,
but never see the fruits of their labor because new visitors aren’t able to find
the site in search engines. Coupling your design efforts with search engine
optimization ensures that people will find and visit your site or blog.

Writing Post Titles That
Make Searchers Click

If you're not already a blogger or a writer, most of your experience in writing
has likely come from writing for school or at work and reading books, period-
icals, or online venues. You've been trained your entire life to write titles that
are a synopsis of the information within the chapter, book report, or article.

Writing for the Web is different primarily because most people actually don’t
read on the Internet. Rather, they browse and scan, searching for answers.
Very few people open a Web page and devour every last word unless it’s writ-
ten by a very remarkable writer.

So, writing a great post title is important because it’s how you hook a reader.
Writing a great post title should accomplish three objectives:

v It should summarize the blog post and set expectations with the
reader that the blog post is relevant to their search.

v It should motivate the searcher to click through to your post. There
might be more relevant results written by much more authoritative
sources. If your post title is compelling enough, though, searchers will
click your entry on the search engine results page more than the others.

v It should have relevant keywords to ensure that the post is properly
indexed. If it’s a long-tail search, you might even find your article in the first
position if no one else uses keywords effectively in their post titles. Chapter
7 provides information on keyword research and long-tail strategies.
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Ten sure-fire headline formulas that work

Headlines are powerful and often underesti-
mated. Selecting a post title that captures peo-
ples’ attention can drive tons of traffic through
search engines and social media. Headlines
are the most important element of your blog
post and the first element to pay attention to.
These formulas are courtesy of Copyblogger
founder Brian Clark.

1. Who Else Wants [blank]?

Starting a headline with “Who Else
Wants .. ." is a classic social-proof strat-
egy that implies an already existing con-
sensus desire. Although this approach is
overused in the Internet marketing arena,
it still works like gangbusters for other sub-
ject matter. Example: Who Else Wants a
Great Blog Template Design?

2. The Secret of [blank]

This formula is used quite a bit— because it
works. Share insider knowledge and trans-
late itinto a benefit for the reader. Example:
The Secret of Successful Podcasting

3. Here Is a Method That Is Helping [blank] to
[blank]

Simply identify your target audience and
the benefit you can provide them, and fill in
the blanks. Example: Here Is a Method That
Is Helping Bloggers Write Better Post Titles

4, Little Known Ways to [blank]

Use a more intriguing (and less common)
way of accomplishing the same thing as
The Secret of [blank] headline. Example:
Little Known Ways to Save on Your Heating
Bill

5.

10.

Get Rid of [problem] Once and For All

This classic formula identifies either a pain-
ful problem or an unfulfilled desire that the
reader wants to remedy. Example: Get Rid
of That Carpet Stain Once and For All

. Here's a Quick Way to [solve a problem]

People love quick and easy when it comes
to solving a nagging problem. Example:
Here's a Quick Way to Back Up Your Hard
Drive

. Now You Can Have [something desirable]

[great circumstance]

This is the classic “have your cake and eat
it, too” headline — and who doesn't like
that? Example: Now You Can Quit Your Job
and Make Even More Money

. [Do something] like [world-class example]

Gatorade milked this one fully with the “Be
Like Mike” campaign featuring Michael
Jordan in the early 1990s. Example: Blog
Like an A-Lister

. Have a[or] Build a[blank] You Can Be Proud Of

Appeal to vanity, dissatisfaction, or shame.
Enough said. Example: Build a Blog Network
You Can Be Proud Of

What Everybody Ought to Know about
[blank]

Big curiosity draw with this type of head-
line, and it acts almost as a challenge to
readers to go ahead and see whether
they’re missing something. Example: What
Everybody Ought to Know about Writing
Great Headlines
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Avoiding link baiting

Some bloggers abuse post titles and use a technique called link baiting. Link
baiters identify trending search keywords using Google Trends or Twitter
Trends. (See Figure 9-1.) Trending search keywords are those rising in popu-
larity and typically denote an event or topic that’s spreading like wildfire
through the Internet.

Take the Google trending topic of the 2010 Olympics, as shown in Figure 9-1.
To bait traffic, you might write a series of blog posts about how your product
or service is like the Olympics. Even though your product has nothing to do
with the Olympics, you might add post titles that include Olympics to draw
the attention of searchers and bait them into clicking your link.

Although this might prove to be a successful short-term strategy for gaining
search engine traffic, you will hurt the long-term strategies that impact rev-
enue because you'll be seen as a search engine spammer and lose credibility.
Visitors will arrive and bounce because they didn’t find the information they
were looking for.
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Getting traffic from the search
engine results page

As prospective customers find your blog posts, their activity won’t be much
different than everyone else’s. They will do a search for a given keyword,
scan the search engine results page (SERP), and click the result they believe
is most applicable. In a given month, a search can be repeated tens or hun-
dreds of thousands of times, but you might not get a single visitor if your
post title isn’t written well.

Figure 9-2 shows an example of an SERP on the Microsoft search engine,
Bing, for the term headline titles. The results page includes sponsored search
results, also known as pay per click (PPC), on the right of the page. Relevant
searches are on the left, and organic results are in the center of the page.

On this page, the first result appears to be a bland article on titles and head-
lines. The next has something to do with job titles. The third result might
even be an error. Although the other titles are accurate, they don’t have the
impact of the fourth result, the copyblogger entry, “How to Write Headlines
That Work.” Following the three points I discuss in the earlier section,
“Writing Post Titles That Make Searchers Click,” the post title is concise and
compelling and sets expectations, makes the search engine user want to click
through, and uses the relevant keywords (in this case, headline).
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Figure 9-3:
Compelling
post titles
ina Google
SERP.

Try another search engine. Take a look at the Google search engine results
page for headline titles to see that copyblogger owns the top two results on
that page. (See Figure 9-3.) These post titles (such as “10 Sure-Fire Headline
Formulas That Work™) are structured a bit differently, but they're still
worded well, and they’ll still capture the attention of any search engine user.

Traditional journalists write titles a few words long that allow a reader to
scan a large newspaper section and find topics of interest. Unfortunately,
journalists often continue to use this style of headline on the Internet, garner-
ing no attention at all. An Internet reader’s behavior is much different than
that of a newspaper reader.

A typical journalist might have written the blog post title, “Blog Provides
Headline Writing Tips.” Would you click that, or would you click “10 Sure-Fire
Headline Formulas That Work”? I thought so! Broken down, the copyblogger
post title sets the following expectations:
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v~ There is a list of ten formulas. Lists are an incredibly powerful tack
because they set absolute expectations on what the reader will find on
the resulting page. People appreciate checklists and intelligently narrow-
ing down a ton of information into a few bullet points.

v The tips are “sure-fire.” This list isn’t a theory, nor does it leave room
for any doubt. These are sure-fire tips, meaning that they have been
proven and tested. The wording is proactive and confident.

As you write your blog post titles, be keenly aware of how they will look to

a search engines. Search engines typically cut off a post title in a SERP at

60 characters, so you must be succinct and creative. A blog post title, for
example, “Acme Web Solutions Announces Partnership with World-renowned
Professor of Analytical Studies from Harvard Business Schools to Release
New Formulas for Ground-breaking Online Marketing Return on Investment
Calculations” exceeds 200 characters!

Search engine users are only going to see “Acme Web Solutions Announces
Partnership with World-renowned.” A better post title might be, “Ground-
breaking ROI Formulas under Development with Harvard.” If that’s not
enough, use your meta description tag to provide additional information (see
Chapter 8).

Search engines will highlight keywords that match the search term used, so
your post title will stand out from the rest if you use keywords within the post
title. People tend to scan left to right and top down on a search engine results
page, so try to keep keywords at the beginning of the post title.

Clicks on a search engine results page follow the same pattern, the top left
entry gets the most clicks and the amount of clicks significantly reduces as
your ranking drops down the page. In Figure 9-4, click patterns follow the
pattern overlaid on the search results page. This is why ranking high for key-
words is important so use them effectively in the beginning of your post titles.

And just because you go ahead and publish a post, that doesn’t mean you
can’t change it! Too many bloggers ignore the fantastic content already writ-
ten, thinking that it’s in the past and forgotten. There are no rules to editing
old post titles. Repurposing is an incredibly effective means of harnessing
search engine traffic.

To find blog posts that rank on page two or deeper in a search engine result,
use a tool like SEMRush (www . semrush . com). SEMRush lists all your pages
and where they rank on search engines. Identifying a post that’s on a second
page and reworking the post title to include keywords and make it more com-
pelling can get that same post to the first page and sometimes even in the top
search result.



204 Part lll: Engaging Your Search Engine Optimization Strategy

|
Figure 9-4:
Where
people click
on a SERP.
|

@ markeling technology blog - Google Search - Windows Ini F=T=m]
K= (A e o guogtescomcaranmiensacutce=ns aaa oq-zaa= ~[ 2[4 ] x {2 aw searcr T
Favatites | 3 marketing technology blag « Google Search B - B -0 - Pagev Saletyw Took v i@-
Web Images Vigeos Mags News Shepgng Gmail mernv kair.douglas@gmail.com | Web tistory | Seltings v | Signeul *
Goc |SIC marketing technology blog Search | asscces et
Wob B Show cotions Results 1- 10 of abaut 47,000,000 for marketing technology blog. (0.41 secends)
Online Marketing Email Marketing Blooaing and Social Media .. Sponisared Links
Ttk Tociioiogy Dioy dicisses i maketg:3ec meds. stach sngne
marketing, blogging. smail marketing, twitter. and analyt AdWords Advertising
-Stais i Emel Comncaions Get Qualfied Visiors To Your Site
marketingtechblog com? - Cac Pt T
WordPress Gontact Form with Spam Protection | Marketing Technology ..
UPDATE Ive discontinuad development of this plugin Instead. | would highly recommend Gravity Fw.ll! Email For Bloggers o
Forma o RochaGRTAS for 8 ey wbLS! o egraon . T00% Free Email Markoting Senice
matkefingtechblog Comprapectsdyp-cantaciiom - Cache ot Stated With MaiChing Today
8 Show mors msults fum marketingtechbing com
Gooale Analvtics Blog
Techn A M ing Law Blog by Eric Goldman - & visi= - /1908 Build = befler websitel Tips &
Discussion dlmsm a0 rtelectal ropery law issues ks on improving enline RO
Seco - Palents - Demative Lisbility nalytics blogspot com
biog encgaidman ory 2
Marketing Technology
MarketingShift The Oriqinal Online Marketing Blog For Fortune 500 Companies
el o bl e ol pace with vl s nestng rul ..y T the And Thase That Want To Be
ol g ol ot - Quaern CSGSystems cam
w marketingshi com - Ca )
Marketing HiTech Products
Buzz Marketing for Technology The definitve source for marketing
Mg Iachaclony oy Woar ot (21 Tachmolouy Makinam: . Far igh-tech products and innavations
o: Social Meda opors. Blog datarepors, Wabsis daa marksthughisch n
markatingfortochnology com - i
Blog Adverfising
Collective C: Get bloggers to wiite about you
Combining marketing and mnnalm 1o develop new markets and grow axisting ones. This Craate branding. increass traffic
blog is pan of Coll ? smorty.com
hiland sok
Technology Marketing
Collective » » Blog Archive .., Message strategy. collateral, sales
Ny 22208 . Conlitia mar kg wd echisoloy 1o deiop new makts i tools, campaigns & social media
existing ones. This blog is par of Golleciie Comersaton . e €2marcom, com
blogs handknowiton cam/social-madiinfugnce-camnal-de-maasured! - Cach Indianzpolis, I
88 Show more results from blogs com Do You Blogsvetise?
- Buid Trafiic and Buzz. Bloggers
the Marketing and Technelogy Blog Writs and Link to your webste
‘marketing-ang-technolegy blogspotcom - www Blogsverise com
Blog E -
@ Internet | Protected Mode: OFf v Ko -

: Wm
ﬁ [ @ \ S

Formatting page titles with post titles

The majority of blogging platforms treat a blog post title as a page title.
Technically, they are different elements. The title is an HTML title tag and

the post title is typically an HTML heading tag. Differentiating page titles and

post titles really squeezes every ounce of optimization from your blog posts
and templates — and, even so, might not result in a significant improvement
in ranking.

In your blog theme’s design, page titles and blog posts titles are distinctly dif-
ferent but often published exactly the same by the blogging platform. Search

engines don'’t treat these two elements equally, however. For them, a page
title is much more important than a blog post title.

Where can you find these elements? A page title is located in the title tags of

your template code and is viewed in the browser page tab or window title (not

within the page content itself). In the example in Figure 9-5, the page title is

<title>Inbound B2B Marketing Strategies and Blogging</title>
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However, the post title is
<h2>B2B Blogging - Webtrends Engage 2010</h2>

The page title accompanies the search engine result page and will register
high for the relevance of keywords for that page. The post title will also regis-
ter well, though, because it’s in an H2 tag. This method is one way that blog-
gers can target a specific title for the search result but another on the page.

Sometimes, the ideal blog post title doesn’t have keywords, so by using this
technique, you can insert relevant keywords in the page title without chang-
ing your blog post’s title. And this allows you to target a variety of words —
in this case B2B, Marketing Strategies, Inbound Marketing, B2B Blogging, B2B
Marketing, Inbound B2B Marketing, and so on.

This method is accomplished by installing the All in One SEO plug-in from
WordPress:

http://wordpress.org/extend/plugins/all-in-one-seo-pack

Other platforms might not offer this option.

@ Inbound BZB Marketing Strategies and Blogging - Mozilla Firefox [=][ErrEs]
File -Edit View H B ! I

- C X A (@ i com/blogging/b2b-blogging/ Bt -] [*8- Googee P
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Using keywords effectively
in page and post titles

If search engine traffic is a strategy that you're pursuing, adding keywords
and compelling titles in your page and post titles is where you want to focus
the most attention.

From a search engine point of view, here are the two key characteristics of a
page title:

1 The length of the title: Search engines currently display only the first 60
characters of a page title. There has been some testing of longer page titles
spotted on Google, but it’s better to concentrate on the lowest common
denominator in this example. Keep your titles within 60 characters.

Because you’re limited to 60 characters, try to avoid words that

have little search engine weight — words like the, is, are, and so on.
WordPress plug-ins, such as the All in One SEO Pack, provide you with
the length of your page title. Other WordPress plug-ins, such as SEO
Post Link, automatically remove unnecessary words and reduce the size
of the title (see http: //www.maxblogpress.com/plugins/spl).

1 Keywords at the beginning of the title: Keywords at the beginning of
the title are more important than those at the end of the title. Try to
start all your titles with the keyword. If you’re having a difficult time, try
using a blog post with the keyword as the first term in the title:

Inbound Marketing: How Blogging could double your
qualified leads online.

One exception to this is the implementation of questions as post titles. Many
search engine users don’t simply type keywords into their search engine:
They type entire questions! If you're answering a common question, you can
attract a lot of long-tail traffic by naming your blog post with the exact ques-
tion. Examples include any of the following:

v How can [ improve search traffic?

v Where is the best restaurant to get cheesecake?

+* What is the best brand of organic dog food?

v+ When should a company implement social media strategies?

v+ How do I protect my blog from getting sued?

A common theme mistake that designers make is to have their blog title pre-
ceding their post title. You'll see page titles that are formatted like this:
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My Blog's Name - My Blog Post Title

Search engines will have no problem differentiating your blog’s title from your
domain and home page because it typically recurs on every page of your blog.
To maximize the effect of your blog post titles but still include your blog’s
name, simply reverse the two in your theme, as in the following. (Hint: Using
a pipe symbol is a common way of differentiating the two from a reader and
from the search engine user.)

My Blog Post Title | My Blog's Name
To format your page title in WordPress, follow these steps:

1. Login to your WordPress Administration panel.
2. Navigate to Appearance=> Editor.

3. In the right sidebar, click Header or header.php to open the header
file.

4. Click Ctrl+S to open your browser’s search field and then enter <title>.

5. When you find your title tag in your theme, change the following line
(see Figure 9-6):

<title><?php bloginfo('name'); ?> <?php if ( is_single() )
{ ?> &raquo; Blog Archive <?php } ?> <?php wp_title(); ?></
title>

to
<title><?php wp_title(); ?></title>

6. Keywords are important at the beginning of the title, so modify your
blog’s name to appear at the end

<title><?php wp_title(); ?> | <?php bloginfo('name'); ?></title>

If you are using Blogger to publish your corporate blog, you can modify the
title tag using these instructions from BlogBloke: http: //www.blogbloke.
com/successful-blog-seo.

Repeating yourself and reusing material

While reading through this book, you’re probably wondering where in the
world you’re going to come up with all your content. If your company is going
to target two blog posts per day, that’s 500 blog posts (250 business days x
two posts). What if you have only a single product?
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How in the world can you come up with 500 blog posts?

You're in luck. Not only is it okay to repeatedly speak about the same topics,
but you should absolutely plan on writing about the same topics repeatedly.

Here are 14 ways to write about the same topic:

Concept Example

Introduction to the Product An Introduction to Blogging

Ten Benetfits of Using the Product  Ten Benefits of Blogging

How to Use the Product How to Blog Effectively

What Is the Product? What Is WordPress?

Product Best Practices Top Plug-ins to Install on WordPress

Product Advice The Fastest Hosting Companies for
WordPress

Product Events WordCamp Los Angeles Is Next Month

Product Comparison WordPress versus TypePad

Product News WordPress Hits One Million Downloads
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Concept Example

Product Testimonials Matt Cutts Loves Blogger

Product Opinion Why Compendium Is the Best Corporate
Blogging Platform

Product Humor How I Learned to Back Up My Blog the
Hard Way

Product Data Blogging Platform Performance
Statistics

Product Share Top Blogging Platform by Market Share

When you listen to your customers and prospects, what are the questions
they’re looking to have answered? These are the questions and keywords
that you will want to target for acquiring search engine traffic.

Using Keywords in Content to Get
Indexed Properly in Search Results

In Chapter 8, I show you details on how search engines find your blog and
index your content. Specifically, using keywords effectively helps your con-
tent to be indexed properly.

If your company has a wide range of products and services that equate to
thousands of or more keywords, you might want to build multiple blogs on
separate subdomains, or even domains, to help concentrate the keywords
you're discussing.

Unless you have amazing search engine authority — meaning that you

have a huge following, tens of thousands of links to your site, and millions of
readers — you may have a difficult time targeting a wide variety of keywords.
Targeting your content as narrowly as possible should educate the search
engines on what your blog’s content is quickly and effectively.

One example is if you do three types of promotion: traditional public rela-
tions, broadcast, and Web. Rather than speak about all of them on a single
blog, maybe start three blogs: one for public relations, one for broadcast, and
one for online marketing.

You can still promote each blog across one another in a sidebar or through
your home page, but concentrating the majority of content on specific key-
words will help you rank more effectively for the terms you're targeting. It will
help you to ultimately target your calls-to-action and landing pages as well.
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Finally, it will be much easier to track the success of each of your programs
with analytics as well. To track multiple subdomains in a single Google
Analytics account, follow these steps:

1. Open your theme editor to the footer with your Google Analytics
script.

2. Below the var pagetracker line and after the semicolon, add the
following line of code, replacing example.com with your domain:

pageTracker._setDomainName (" .example.com") ;

3. Log in to Google Analytics, navigate to your blog’s profile, and then
click Edit in the Action column.

. In the Filters Applied to Profile section, click Add Filter.
. Select Apply New Filter for Profile.

. Enter Subdomain as the Filter Name.

. Select Custom Filter as the Filter Type.

. Select the Advanced radio button.

© X N G e

. For Field A -> Extract A, select Hostname from the Field drop-down list
and then enter (.*) in the Value field.

10. For Field B -> Extract B, select Request URI from the Field drop-down
list and then enter (.*) in the Value field.

11. For Output To -> Constructor, select Request URI from the Field drop-
down list and then enter /$A1$B1 as the constructor.

Within that profile, you can now segment and organize the Analytics
data. (See Figure 9-7.)

Using the correct balance
of keywords and content

If you stuff keywords into every blog post, you're actually putting your blog
at risk of being buried in the search engine results. This is called keyword
stuffing. Aside from blatantly repeating keywords in your content, you can
also be dropped from a search engine’s results if you're adding keywords in
hidden text, or stuffing keywords in title tags and alt attributes.

And keyword stuffing doesn’t just put your blog at risk of being penalized
by search engines. It’s going to drive readers away, your blog will lose cred-
ibility, and you’ll ultimately lose the opportunity to close business with your
corporate blog.
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Too many corporate blogs that concentrate on search engine traffic win the
battle (ranking in search engines) but ultimately lose the war (converting
traffic into customers). Don’t be tempted to stuff keywords.

Instead, write compelling, natural content that will attract readers and con-
vert them. A common SEO practice for using keywords is to first write your
post, and then see where keywords will naturally fit.

To write a keyword-rich blog post, follow these steps:
1. Write three or four paragraphs of two to three sentences, each on a
topic associated with your product or service.
2. Write a compelling post title.

3. Research keywords that people are searching for. See Chapter 8 for
information and tools to help you find the right keywords.

4. Rewrite the post title with the keywords, trying to place them first.

5. Rewrite the first and second sentence of the opening paragraph and
use a keyword naturally in the paragraph.
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6. Review each subsequent paragraph and look for opportunities to
insert a keyword.

7. Read your post title and blog post and ensure that it sounds natural,
without too many keywords repeated.

The primary goal of your blog is to drive business. That means that every
blog post should be written with a purpose. If that purpose is to close a sale,
make sure you have a call-to-action: for example, Fill out our registration form,
Contact me, Download our whitepaper, Register for our event, and so on. If that
purpose is to drive authority, ensure that the blog is noteworthy.

Optimizing your post should not affect the effectiveness of the content in
making customers out of visitors! Review the content and carefully place key-
words where they will make sense to a reader. A crawler will understand the
keywords that are being targeted.

Finding synonymous keywords
and phrases

As you insert keywords, keep in mind that you need not use the same expres-
sion over and over again. Search engines help you in this by associating key-
words to blogs through synonymous terms.

As an example, if one of the keywords you’re targeting is cheap, you don’t
need to blog about cheap per se, which can have a negative connotation.
Words like wholesale, inexpensive, and discount are common synonyms with
less negative connotations. These terms will also ensure your content is
indexed properly and found.

If you're having trouble identifying synonymous keyword terms, try these tips:

1 Related search terms are provided by search engines. In Google, scroll
to the bottom or to the SERP to find related search terms. In Bing, the
related searches are listed in the left sidebar. (See Figure 9-8.)

1 Review your analytics if you're already getting traffic on keywords.
Often, your analytics (in Google Analytics, navigate to Traffic Sourcesw
Keywords) will provide combinations and synonymous terms.

v Using an application like SpyFu (www. spyfu.com) or SEMRush (www.
semrush.com). With these applications, you can do competitive analy-
sis and find the common keywords between you and your competition.
Or you can review your competition’s keywords altogether.
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Keywords that drive traffic are important, but keywords that drive business
are more important. Take the example of Brozzini Pizzeria, a New York-style
pizzeria in Indianapolis. If Brozzini’s blog ranks #1 for New York style pizza, it’s
not going to do his business any good. However, if he ranks for Indianapolis

Driving Home the Message
with Images and Diagrams

You made it all the way to this chapter, and now you’re going to get some
news that may be shocking — people who visit your blog don’t read. Okay,
they do read a little bit . . . barely. There’s a reason why they call Web surfing
applications browsers.

New York-style pizza, he will get a ton of relevant business. (See Figure 9-9.)
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As I mention earlier, the average visitor to your site will scan the content to
see whether he can find what he wants. Most visitors will take in what they
can and then immediately bounce. That’s disconcerting, but you can do
things to help them stay, including the following:

+~ Use photos, images, diagrams, and other visuals that represent your
message well. Even when we read, our minds are a complex system that
remembers images, not words. By supplying an image, you're making it
easier for your content to be consumed and understood, thus encourag-
ing the visitor to remain.

v Use videos. If pictures are worth a thousand words, videos are worth
millions. Take advantage of inexpensive video equipment and video
hosting services to produce videos as periodic blog posts.

1 Use effective whitespace. Claude Debussy commented on music and
the “space between the notes.” Just as important as the words on your
blog are the spaces between them. Ensure that the font you use is easily
readable, spacing is used, bulleted and numbered lists are used often,
keywords are bolded, and your posts are enhanced with images and
video to help to improve cognition. Short, punchy paragraphs, subtitles,
indenting, bold, and italic all help break up the monotony of the docu-
ment and make it easier to scan. The upcoming section, "Considering
the importance of whitespace,” discusses using whitespace effectively.
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The next few sections discuss these in greater detail.

Using alt tags effectively for image
searches and keyword placement

Hypertext Markup Language (HTML) is the programming language of the
Web. An HTML alt tag contains alternate text associated with a Web page
graphic that displays when an Internet user hovers the mouse on the graphic.
Every image or embedded object can have alternative text. A1t tags make the
Web more accessible, specifically for the blind who use software applications
(called screen readers) that read the text aloud. When an image is found in
the content, the screen reader reads the alternative text — the alt tag.

Alt tags are used in several scenarios, such as the following:

v~ Alternative text comes in handy when you have a slow connection to the
Web and don’t want to wait for an image to download.

v~ Alternative text is often used by mobile devices and mobile browsers.
For example, each time you open a Web page with a BlackBerry device,
the images aren’t downloaded but display with a border and the alterna-
tive text. You may then request to download the images.

v Alternative text is used by screen readers for visitors who have visual
disabilities.

For these reasons, alternative text should be entered to describe the images
or objects that you embed.

<img src="/image-directory/myimage.jpg" alt="alternative
text describing image" title="title of the
image" desc="There's even an element to put a
very long description of an image or object" />

As with your content, this is a fantastic opportunity to insert keywords.
Although alternative text is typical, title and description elements can accom-
pany an image, too. Depending on how advanced your editing tools are in
your blogging platform, you can enter one or all of these fields.

Don’t ignore the opportunity to use a keyword within a title, alternative text,
or description field that describes the image or object.

Search engines also have image search methodologies and people are often
looking for photos of products, companies, logos, diagrams, and charts. By
providing the images that searchers are looking for, you may find that your
blog is growing in both search authority and readership because of the quality
of your images.
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Using representative images for
improved comprehension

Your blog’s visitors read words but remember images. Because of this, keep
the following tips in mind:

v Use photos, images, diagrams, and other visuals that represent your
message well. Even when we read, our minds are a complex system
that remembers images, not words. By supplying an image, you make it
easier to consume your content and be understood, which encourages a
visitor to remain.

v~ If pictures are worth a thousand words, videos are worth millions. Take
advantage of inexpensive video equipment and video hosting services to
periodically produce videos as blog posts.

v Ensure your font is easily readable, spacing is used, bulleted and num-
bered lists are used, keywords are bolded, and your posts are enhanced
with images and video. All these help to improve cognition.

Effectively sizing and formatting

images for your page

When you find images to display in your blogs, you want to size and locate
them properly in the post for maximum impact. Ensure that your images are
saved in a high quality format. The PNG format is universal, allows for trans-

parent sections, is compressed as much as possible, and maintains image
quality. It’s a great format for online viewing.

You may want to insert a small image, such as a logo, wherever it makes
sense. If it’s an image that displays data or a chart, resize the image to the
maximum width of your blog’s content column. If you’re not sure how large
that is, it’s fairly easy to discover.

To determine your blog content area’s width using Firefox, follow these
steps:

1. Navigate to Tools=>Add-ons.

2. Select Get Add-ons.

3. Type Measure in the search field.

4. Locate the Measurelt Add-on and select Add to Firefox.
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. Select Install Now.
. Restart Firefox.

5

6

7. Navigate to your blog.

8. In the status bar on the lower left, click the ruler icon.
9

. Drag the mouse across your content area. (See Figure 9-10.)

10. Record the width so you remember how to size your images.

Your images should be resized appropriately to match your theme and to
differentiate your blog posts that are read from the feed in an RSS reader.
Resizing and aligning your images maintains the aesthetics — that is, the look
and feel, of your blog.

If you align an image left or right, divide your content width into thirds or
two halves. (See Figure 9-11.) This grid styling is not just all the rage on the
Internet, it also keeps pages looking clean and neat. When all your images are
proportional to your theme’s layout, your blog will maintain a professional
look and feel.
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Figure 9-11:
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Business buyers and consumers want to ensure they’re buying from a repu-
table source, so keeping your theme and your blog post layouts looking
professional does have a return on investment. It only takes a few minutes to
properly prepare a post that can turn into revenue.

Here are some quick tips for properly formatting images:

1+ Width and height: Make sure that the ratio proportions are locked to
ensure the image resizes proportionally. Note that images are resized to
a lower resolution to speed load times.

To resize an image using Paint, follow these steps:

1.
2.

Navigate to Start=>All Programs->Accessories=Paint.

Open the image you wish to resize. Click the document icon on
the left of your tabs and select Open.

. Click the Home tab.

. Click the Image>Resize icon.

The Resize and Skew window appears. (See Figure 9-12.)

. In the window, change the Resize By field to Pixels by selecting

that option.

. Be sure Maintain Aspect Ratio is checked.

This adjusts the height or width to make sure your image main-
tains its proportions and doesn’t become skewed.

. Enter the width in the Horizontal field.
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Depending on the quality of the image and the layout you devel-
oped, make the width the entire width, half the width, or one-third
the width of your blog post).

8. Click OK.
9. Save the image after it’s sized for your blog.

v Padding: Padding is the amount of space you wish to maintain around
an object. If you insert an image and don’t set any padding, the image
may display directly next to your text, making it difficult to read. In your
theme, you should be able to add padding to maintain space between
your image and your text.

A typical method used is to add two classes to your theme’s stylesheet,
one for each alignment.

img.alignleft {
text-align: left;
padding-right: 8px;
padding-bottom: 5px;

}

img.alignright {
text-align: right;
padding-left: 8px;
padding-bottom: 5px;

}

Now, when you insert your image, you simply need to ensure the class,
like this:

<img src="/directory/image.png" class="alignleft"
alt="This is an image aligned left" />
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v~ Align: Adjust the image in relation to the text to ensure that it’s easier
for blog readers to follow the content of the post and to catch their eyes.

v Description: This isn’t really a formatting field. This is a field for search
engines. Make sure to label the image with a description that’s relevant
to the image and the content in your post. If relevant, include a keyword-
rich phrase.

Finding free quality images to use on your blog can be a challenge. Many
choices for stock photography are available online, though. Here is a list of
several sites that | have used. Check them out, try them out, and find out
what works best for you.

v Flickr: www. flickr.com
v morgueFile: www.morguefile.com
v Stock. XCHNG: www . sxc.hu
v Dreamstime: www . dreamstime.com
v FreeFoto.com: www . freefoto.com
v PicApp: www.picapp.com
A good rule is to make sure you check the copyright restrictions and provide

attribution. And because every organization handles image guidelines differ-
ently, make sure you contact your blog admin for specific guidelines.

Google Images search can also be used. From the Google home page, click
the Images link in the top-left corner. Click the Advanced Image Search link
that follows the Search button and then choose Labeled for Commercial
Reuse from the Usage Rights drop-down menu.

Make sure you check the copyright restrictions and provide attribution. A
typical fine for reusing an image can exceed $1,000! Even Google’s licensing
search isn’t foolproof. Google doesn’t take any responsibility if you choose an
image you think you can use for commercial reuse and you actually cannot.

Additionally, if you find an image available for commercial reuse but that
image is actually displayed in violation, too, your company is still liable.

Formatting Your Posts for
Better Comprehension

When readers scan pages, they read from the top left to bottom right and
focus mainly on the beginning of paragraphs. Therefore, when you write, you
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want to ensure that you have powerful content in the areas that visitors pay
the most attention to.

Here are four things you can do to improve your formatting:

* Keep your paragraphs short and leave space between them. Make sure
you leave space — whitespace — around your images.

1+ Use numbered and ordered lists often. Such lists stand out and are
simple to digest.

1 Keep your posts pithy. Try to keep to the point. Talk about a single
point in each post and keep your explanations brief and concise. Your
posts should be enough to explain your point but never longer. If you
have multiple points, use multiple posts.

+ Emphasize important elements of the post. Use bold, italic, and high-
lights. Bolded text stands out for search engines as well.

Considering the importance of whitespace

Make sure you leave space around your images and paragraphs. This is
called whitespace and is more important than people realize. Visitors who are
scanning your site will tend to skip over large chunks of text that have no dif-
ferentiation. If text runs into borders or images, it’s more difficult for the eye
to discern and comprehend the information.

Using bulleted and ordered lists

Lists are easy to digest and scan vertically on the page. Your visitors will
skim over paragraphs, but an ordered list or bulleted list will be easier
for them to digest. Try to use lists as much as possible. Be sure to leave
whitespace around the list and between each list item.

Highlight a keyword or two within each of your list items. This will make it
even easier to scan.

Sizing paragraphs for easy scanning

In high school English class you learn to open your paragraph with a sen-
tence that introduces the topic, followed by three to five sentences of detail
and a concluding sentence that sums it up. Forget what you learned in high
school and jump directly to the concluding sentence.
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Unless you’re selling books with detailed prose that you want to provide
examples of on your blog, you need to keep your paragraphs as short and
pithy as you possibly can so that visitors get directly to the point.

Writing High Converting Content

Your objective when writing content is to build authority, gain trust, and ulti-
mately, get business. Several techniques for writing content converts traffic
into business.

Do your visitors understand the reward of engaging with your company? It’s
not enough to simply talk about your company, your products or services;
you must relate the content directly to the readers’ benefits. How are they
rewarded for purchasing, for signing up, for downloading, and for engaging?

Reward-driven blog posts often use customer testimonials. Customer tes-
timonials provide your blog post an additional level of trust and authority
because you provide distinct examples of others who have been rewarded.
Don’t underestimate the power of a customer testimonial. Ask your custom-
ers for them often.

The most important technique, of course, is to ensure that every blog post is
written with a blatantly obvious path for the reader to engage with you further.
Don’t rely on only calls-to-action or banner advertising on your theme — some
people aren’t actually reading your blog at your site! Closing each blog post
with an invitation for the reader to engage with you, including how they can
do so, is a great method for increasing conversion rates.

Actionable engagement terms for your blog posts include:

“If you'd like to discuss this further...”

“We’ve got a Webinar on this coming up, here’s how to register.”
“Click here to add this product to your shopping cart.”

“If you'd like to donate now, here’s an online form.”

“Check out our product page.”

“This is just an overview, be sure to check out our demo.”



Chapter 9: Writing Content That Drives Search Engine Traffic 223

Each term, of course, should be written with an anchor tag that will allow the
reader to click it and land where you’d like them to.

Additionally, don’t try to pack too much information into a blog post. Blogs
have categories, searches, tags, and related content suggestions to provide
additional insight to your visitor. Keep each blog post limited to a single idea.
One post, one topic — that should be your rule.

If you find yourself writing a long post that covers a collection of topics that
are related, break them up. It’s okay to post multipart blog posts that encour-
age the reader to come back and visit your “Five Part Serieson . . .”

After you complete your blog post or review someone else’s, ask yourself,
“What was the question?” If the question is clear, you've got a good blog post.
Now make sure that you answer the question! You may not want to give away
proprietary or competitive information in your answer but tell your readers
how to engage you to get it. Answer the question they are asking.
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